
ESTUDO DE ESTRUTURA COMPOSTA POR BARRAS E CABOS USANDO O 

ABAQUS 6.12 STUDENT EDITION 

 

1. INTRODUÇÃO 

 

1.1. DESCRIÇÃO DO PROBLEMA: 

 

 A estrutura do presente exemplo é composta por barras submetidas à 

flexão e por um cabo, conforme mostra a figura abaixo, apresentado por Beer e 

Jonhson, 3a Edição, na referência Mecânica Vetorial para Engenheiros, Vol. 1 - 

Estática. Pedem-se as tensões no cabo e as reações nos apoios. 

 

 

 
1.2. PROPRIEDADES GEOMÉTRICAS 

 

 Vigas; 

 AREA = 0.562500E-2 m2; 



   IZZ = 0.263672E-5 m4; 

   IYY = 0.263672E-5 m4; 

 

 

 Cabos; 

   AREA = 0.1E-2 m2; 

    ISTR = 0.1E-8 

 

1.3. PROPRIEDADES DOS MATERIAIS  

 

Módulo de elasticidade dos materiais: 0.21E12 Pa. 

 

1.4. CARGAS 

 

F1= -1500 N 

F2= -500 N 

 

1.5. DEFINIÇÃO DO RECURSO DE VIGAS 

 

 Visão são elementos considerados unidimensionais, aproximação da 

tridimensionalidade devido às pequenas dimensões de sua seção transversal 

quando comparadas ao seu comprimento.  Diferentemente de estruturas de 

treliça, vigas são elementos em linha que têm rigidez a deformações não 

apenas axiais, mas também a flexão, torção e cisalhamento. Descreveremos 

esses elementos de barras, indicados por BEAM no programa ABAQUS/CAE. 

É relevante, pois, considerar características do material constituinte, e também 

características geométricas da seção transversal da viga, o que é possível 

definindo informações de seu perfil.  No fim dessa aula, espera-se que o aluno 

aprenda tais procedimentos, de forma que ele seja capaz de usá-los para cobrir 

outras aplicações. 

 



   
 

 

Figura 2. Elemento de Viga – BEAM 

 
1.6. CARACTERÍSTICAS DO ELEMENTO: 

 

 Elementos relativamente longos e finos que podem transmitir 

esforços axiais, cortantes e fletores 

 Aplicável em modelos de duas ou três dimensões. 

 Graus de liberdade:  

 

 Vigas tridimensionais: têm seis graus de liberdade em 

 cada nó: três graus de liberdade de translação (1-3) e 

 três graus de liberdade de rotação (4-6). Pode-se tem um 

 grau de liberdade adicional (7) no caso de deformações 

 de seções transversais abertas. 

 

 Vigas bidimensionais: têm três graus de liberdade em cada 

 nó: dois graus de liberdade de translação (1 e 2) e um 

 grau de liberdade de rotação (6) sobre a normal ao plano 

 do modelo. 

 

  

  

 



 Pode-se definir uma seção transversal e suas dimensões, ou 

definir uma seção qualquer, inserindo suas características, como 

área e momento de inércia. 

 

 Nomenclatura no ABAQUS/CAE: 

 
 

   

 Figura 3. Nomenclatura no ABACUS/CAE (Abaqus Analysis User's 
Manual) 

 

 É necessário definir a orientação dos eixos coordenados ao longo da 

viga, definidos pelos vetores t (tangente à viga) e n (normal à viga).  

 

  

Figura 4 – Orientação dos eixos coordenados (Abaqus Analysis User's Manual) 

  

2. RESOLUÇÃO 

 

O procedimento de resolução pode ser demonstrado no seguinte 

fluxograma (a ordem pode eventualmente ser quebrada em pontos específicos 

por conveniência): 



 

PRÉ-PROCESSAMENTO 

Início da Análise 

Criação da geometria base (Parts) Definir Tipo de Elementos 

Atribuição das propriedades dos 
materiais (Materials) 

Atribuição das propriedades das 
seções das barras (Sections) 

Associação das Seções, geometria 
base, materiais... (Section 
Assignments) (Assembly) 

Aplicarção das condições de 
contorno 

Cargas (Loads) 

Apoios (BCs) 

Criação da geometria da malha 
(Mesh) 

Elementos cálculaveis pelo 
método dos elementos finitos. 
Aproximação da estrutura real. 

Definição das Variáveis de Saída 
(Field Output Requests) 

PROCESSAMENTO 
Solução, Cálculos 

Computacionais (Jobs)  

PÓS-PROCESSAMENTO Análise dos resultados 

Variavéis de saída 

Análise gráfica 



 

2.1. INÍCIO DA ANÁLISE 

 

 Se você ainda não iniciou o programa Abaqus/CAE, digite cmd no 

Menu Iniciar para abrir o Prompt de Comando e nele digite 

abq6122se cae para executar o Abaqus. 

 Em Create Model Database na caixa Start Session que aparece, 

selecione With Standard/Explicit Model. 

 

2.2. PRÉ-PROCESSAMENTO 

 No menu Model à esquerda, clique com o botão direito em Model-1 e 

selecione Rename. Digite EstruturadeBarraseCabos. 

 No menu Model à esquerda, dê duplo clique em Parts, no campo Name 

digite Cabos, e selecione as opções: 2D Planar, Deformable, Wire. 

Em approximate size digite 20. Clique em Continue... 

 

 

 Para começar a criar a estrutura, clique em Create Lines: Connected 

na caixa de ferramentas e insira em ordem as seguintes coordenadas 

(tecle enter entre uma e outra coordenada): 0,0 – 0,3 – 1.5,4.5  – 6.9,3. 

Em seguida, desative a função Create Lines: Connected e clique em 

Done. 



 

 

 No menu Model à esquerda, dê duplo clique em Parts, no campo Name 

digite EstruturaPrincipal, e selecione as opções: 2D Planar, 

Deformable, Wire. Em approximate size digite 20. Clique em 

Continue... 

 

 
 Clique em Create Lines: Connected na caixa de ferramentas e insira 

em ordem as seguintes coordenadas (tecle enter entre uma e outra 

coordenada): 1.5,0 – 1.5,3 – 0,3 – 1.5,3 – 1.5,4.5 – 1.5,3 – 3.45,3 – 5.1,3 

- 6.9,3. Desative a função Create Lines: Connected e clique em Done. 



 

 

 No menu Model à esquerda, dê duplo clique em Sections. No campo 

Name digite SeçãoCabo, em Category selecione Beam, e em Type 

selecione Truss. Clique em Continue... Na janela Edit Section, clique 

em Create Material. Na janela Edit Material, escreva MaterialCabo no 

campo . Clique em Mechanical>Elasticity>Elastic. Em Data, no Name

campo Young’s Modulus digite 0.21E12, em Elastic marque a opção ,  

“no compression” e clique OK. Em  , insira a área Cross-sectional area

de 0.1E-2 e clique em .  OK

 

 



 No menu Model à esquerda, dê duplo clique em Sections. No campo 

Name digite SeçãoEstrutura, em Category selecione Beam, e em 

Type selecione Beam. Clique em Continue... Na janela Edit Beam 

Section , ao lado de  , clique em  Profile name Create Beam Profile.

Selecione o perfil , nomeie-o Perfil1 e clique em Generalized

 Continue...

 

 
 Na janela  insira em  0.5625E-2 , em  0.2637E-5 , Edit Profile, area I11

em  0, em  0.2637E-5. Clique em .  I12 I22 OK

 



 Um aviso surgirá. Clique em , e altere o campo Dismiss Section 

 para . Em , digite integration Before analysis Young’s Modulus

0.21E12 , e em , 0.105E12 .Clique em .  Shear modulus OK

 

 

 No menu Model à esquerda, abra Parts>Cabos e dê duplo clique em 

Section Assignments. Selecione o todo o cabo e clique em Done. 

Selecione , em Section, Seção Cabo e clique em OK. 

 

 

 Repita esse processo para associar à seção SeçãoEstrutura na parte 

EstruturaPrincipal, mas agora trocando o nome do set de Set-1 para Set-

2 ao selecionar a estrutura. 



 

 

 No menu Model à esquerda, abra Assembly e dê duplo clique em 

Instances. Certifique-se que o Instance Type consta em “Dependent 

, selecione ambas as partes e clique em OK. (mesh on part)”

 

 

 Na caixa de ferramentas, clique em . Em  Merge/Cut Instances Part

 digite Estruturatotal. Aceite os padrões, como mostra a imagem, name

e clique em Continue... Selecione o todo e clique em  . Done



 

 

 Na caixa de ferramentas, selecione Assign Beam Orientation. Clique 

em , selecione Sets Set-2 e clique em   Tecle Enter e clique Continue...

em .  OK

 

 

 No menu model à esquerda, dê duplo clique em Steps. No campo 

Name, digite Carregamento. Clique em Continue.... Então clique OK 

na nova janela que se abre. 



 

 

 No menu model à esquerda, dê duplo clique em BCs. Na janela Create 

Boundary Condition, altere o campo Name para Apoio Fixo, Step para 

Initial e Types for Selected Step para Displacement/Rotation. Clique 

em Continue....  

 

 

 Selecione a ponta do apoio fixo e clique em Done. Marque na nova 

janela U1 e U2. Clique em OK. 



 

 

 

 Repita o procedimento para criar o Engaste, marcando “Symetry/ 

antisymmetry/Encastre”, selecionando a ponta do engaste, e 

“ENCASTRE(U1=U2=U3=UR1=UR2=UR3=0)” em Edit Boundary 

Condition.  

 

 

 No menu model à esquerda, dê duplo clique em Loads. Na janela 

Create Load, no campo Name digite F500, troque o Step para 

Carregamento e clique em Continue.... 

 



 

 

 Selecione o ponto intermediário esquerdo (de coordenada 3.45,3), e 

clique em Done. Na janela Edit Load, no campo CF2 digite -500 e 

clique em OK. 

 

 

 Repita o procedimento para criar a carga F1500, aplicada no ponto 

intermediário direito (de coordenada 5.1,3), de intensidade -1500 (CF2). 

 

 No menu model à esquerda, abra Parts>Estruturatotal e dê dois 

cliques em Mesh. Na barra de contexto, em Object, selecione Part. Na 

barra do menu principal, clique em Mesh>Element Type e selecione 



com o mouse toda a região do cabo. Clicando em Done, abrirá a janela 

Element Type. Em Family, selecione Truss e clique OK. 

 

 

 Selecione com o mouse todas as barras. Clicando em Done, abrirá a 

janela Element Type. Em Family, selecione Beam e em Geometric 

Order, selecione Quadratic. Clique OK. 

 

 

 Na barra do menu principal, clique em Seed>Edge e selecione as 

barras. Em digite 0.2 . Clique em . approximate element size OK

Selecione os cabos e clique em . Altere  para Done Method  By number

e  para 1. Number of elements



 
 

 Na barra do menu principal, clique em Mesh>Part. Aparecerá a 

pergunta “OK to mesh the part?”, clique Yes. Perceba que o cabo fica 

na cor azul. 

 

 No menu model à esquerda, abra  . Clique com Field Output Requests

o botão direito do mouse em F-Output-1 , e clique em  Mantenha Edit... 

selecionadas as variáveis padrões, acrescentando SF: Sections forces 

 em  and moments Forces/Reactions



 

 

 

2.3. PROCESSAMENTO 

 

 . No menu model à esquerda, duplo clique em Jobs. Na janela Create 

Job, apenas clique em Continue.... Na janela Edit Job, clique em OK. 

Abra Jobs e clique com o botão direito em Job-1. Clique em Submit. 

Se aparecer uma janela dizendo “Job files already exist for Job-1. OK to 

overwrite?”, clique OK. Aguarde o processamento dos dados. Estará 

concluído quando aparecer “(Completed)” ao lado de Job-1 no menu 

model à esquerda. 

 

 

2.4. PÓS-PROCESSAMENTO 

 

 No menu model à esquerda, clique com o botão direito em Job-

1(Completed)>Results. A tela de análise de dados se abrirá. Na caixa 

de ferramentas, clique em Plot Contours on Deformed Shape.  



 

 

 

 Na barra de ferramentas no canto superior à direita, selecione S11 

onde, por padrão, estava selecionado Mises. Na barra de menu 

principal, clique em Viewport>Viewport Annotation Options.... Na 

janela aberta, selecione a aba Legend. Clique em Set Font. Na nova 

janela, altere Size para 14. Clique OK nas duas janelas abertas. 

 

 

 Na barra de menu principal, clique em Report>Field Output. Na janela 

Report Field Output, clique em S: Stress components>S11 e clique 

em OK. A mensagem aparecerá: “The field output report was appended 



to file “abaqus.rpt”.” O arquivo abaqus.rpt pode ser encontrado em  

C:\Users\”Nome do Usuário”\abaqus.rpt. 

 

 O arquivo listará os esforços nos cabos. 

 

 

 Para analisar os esforços nas barras, selecione na barra de contexto SF 

(SF1: esforço axial. SF2: esforço cortante). Para analisar os momentos 

fletores, selecione na barra de contexto SM>SM1.  

 

 



 Na barra de menu principal, clique em Report>Field Output. Na janela 

Report Field Output, clique em SF: Section Forces e SM: Section 

Moments .Clique em OK 

 

 
 O arquivo listará os esforços na viga. 

 

 

 Na barra do menu principal, clique em Report Field Output. Na janela 

Report Field Output, desmarque Section Forces e Section Moments  

e no campo Position selecione Unique Nodal. Então marque 

U:Spatial Displacement e clique OK.  

 



 O arquivo listará as deformações na estrutura. 

 

 

 

 Na barra do menu principal, clique em Report Field Output. Na janela 

Report Field Output, desmarque U:Spacial Displacement e então 

marque RF: Reaction force e clique OK.  

 O arquivo listará as reações de apoio. 

 

 



 Na barra do menu principal, clique em File>Save As.... Dê um nome ao 

arquivo e clique em OK (É possível também salvar o arquivo com os 

resultados já calculados - job-1.odb). 


